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Connexion avec votre compte Ti

Pour utiliser le logiciel d'émulation TI-SmartView™ pour calculatrices MathPrint™, vous

devez vous connecter avec votre com pte Tl

Lancez le logiciel d'émulation TI-SmartView™ pour calculatrices MathPrint™.

S'il s'agit du premier lancement du logiciel, vous étes invité a accepter la licence,

1.
la politique de confidentialité et les conditions d'utilisation en ligne.
= x
W TEXAS INSTRUMENTS
By using the application, you indicate your agreement with the
terms and conditions of the License, TI's Privacy Policy, and Tl's
Online Terms of Use.
Cliquez sur Accept.
2.

Dans l'invite de connexion, cliquez sur LAUNCH SIGN IN.

]

Please sign in to your account to continue.
"]

PURCHASE LICENSE LAUNCH SIGN IN

X

Remarque : Si vous devez acheter une licence mono-utilisateur, cliquez sur

PURCHASE LICENSE.

Cela a pour effet d'ouvrir la page de connexion de Texas Instruments dans votre
navigateur. Suivez la procédure de connexion avec un compte Google ou avec
|'adresse e-mail associée a votre compte TI.

x
Please sign in to continue

i3 TEXAS INSTRUMENTS

SIGN IN

© scmmmicooa

Or sign in with email

1 Email (user name) ¢

1 Connexion avec votre compte T/



Une fois que votre compte est validé, un message d'opération réussie s'affiche
dans le navigateur et le logiciel s'ouvre.

Affichage des informations de licence

Une fois que vous étes connecté, vous pouvez consulter les informations relatives a
votre licence.

» Accédez a Help > License Info.

= x
Account Info
email@domain.com

Subscription Expiration
2026-12-30

Session Expiration
6 Days 23 Hours 56 Minutes

Account Info : adresse e-mail de ['utilisateur actuel.

Subscription Expiration : date d'expiration de la licence actuelle du logiciel.
Session Expiration : temps restant pour la session en cours.

Pendant que le logiciel est en cours d'utilisation, il se connecte au systeme de
gestion des licences toutes les 15 minutes. Si I'utilisateur se déconnecte a un

moment donné, le logiciel continue de fonctionner pendant sept jours a compter de

la date de la derniére connexion.

Déconnexion de votre compte
1. Accédez a Help > Sign Out.
2. Cliquez sur SIGN OUT.

Le logiciel se ferme et un onglet du navigateur ouvre la page de connexion.

La déconnexion a pour effet d'enregistrer |'état actuel et de libérer la licence qui
redevient disponible dans le pool de postes disponibles. La fermeture du logiciel via

Fichier > Quitter ou via le bouton de fermeture n'entraine pas
automatiquement la déconnexion de |'utilisateur et la libération de la licence.

Connexion avec votre compte T|
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Introduction au logiciel d'émulation TI-SmartView™ pour
calculatrices MathPrint™

Le logiciel TI-SmartView™ est un émulateur vous permettant d'afficher une
calculatrice scientifique TI MathPrint™ afin qu'elle soit visible par tous les éléves de la
classe.

Espace de travail Calculator Emulator (Emulateur de calculatrice)

Permet d'exécuter les opérations suivantes :

e Choisir un émulateur

{

% — Permet de choisir I'émulateur que vous souhaitez utiliser.
TI-30X Plus MathPrint™

TI-30X Pro MathPrint™

— TI-30XS MultiView - TI-30XB MultiView™

TI-34 MultiView™

e Masquer/Afficher I'émulateur en mode écran large

— Affichez la vue totale de I'émulateur avec ou sans le volet Large
Display Screen (Ecran large).

e Masquer/Afficher I'historique des touches activées

— Affiche les images des touches activées pour que les éléves puissent
suivre les séquences de touches utilisées.

e Lancer une fenétre de capture d'écran distincte

— Capture et enregistre les écrans d'émulateur dans des fichiers
d'ordinateur sur le méme principe qu'avec la fonction de capture
d'écran de la calculatrice Tl Connect™ CE.

Voir : Utilisation de I'espace de travail de I'émulateur de calculatrice pour optimiser
vos présentations en classe.
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Premier lancement : Sélection d'un type d'émulateur

Lorsque vous lancez pour la premiere fois TI-SmartView™ pour MathPrint™ sur votre
ordinateur, une boite de dialogue de notification s'affiche.

{17 Available Emulators
Select a default emulator:

TI-30X Plus MathPrint
TI-30X Pro MathPrint re using the
TI-30XS MultiView gt

Ti-34 MultiView

X

Choisissez un type d'émulateur dans le menu
déroulant, puis cliquez sur OK.

L'émulateur que vous avez sélectionné
s'affichera lors de votre premiere présentation.

TI-SmartView™ pour MathPrint™ redémarrera toujours en appliquant le dernier état du
logiciel. Une fois le logiciel ouvert, vous pouvez changer |'émulateur défini par défaut.

Voir : Choix d'un type d'émulateur.

Le dernier type d'émulateur utilisé deviendra I'émulateur défini par défaut et la
derniére taille de la fenétre s'appliquera en fonction de vos derniers réglages.

Voir : Changement de taille du volet Large Display Screen (Ecran large) de I'émulateur

TI-SmartView™

Introduction au logiciel d'émulation TI-SmartView™ pour calculatrices MathPrint™ 4



Utilisation de I'espace de travail de I'émulateur TI-
SmartView™ pour calculatrices MathPrint™

L'espace de travail de I'émulateur TI-SmartView™ pour calculatrices MathPrint™
comprend des outils pratiques pour entrer des calculs.

"B TI-smartview™ for MathPrint™ cakulators

File Edit View Actions Help

B :maa @

fponsrsmmes TI-30X Plus
It
w

nsert

(6]

7

Key Press History

setop
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Composants de I'espace de travail de I'émulateur TI-SmartView™

o

File Edit View Actions Help

Barre de menus : utilisez ces menus pour exécuter toutes les fonctions de
I'émulateur, notamment :

e File (Fichier) : Exit or Quit ® Actions (Actions) : capture d'écran, par
(Quitter) exemple

e Edit (Edition) : comprend la
copie de touche entant que ¢ Help (Aide) : accés a I'aide et aux liens
police

e View (Affichage) :
changement d'affichage

Remarque : Vous pouvez exécuter la plupart des actions a partir de ces menus
en cliquant sur les icones de la barre d'outils.

B Zaa @

Toolbar (Barre d'outils) : utilisez les icones de cette barre d'outils pour :
e Sélectionner un autre modele de calculatrice

e Afficher ou masquer le volet Large Display Screen (Ecran d'affichage large)
et le volet Key Press History (Historique des touches activées)

e Capturer I'écran actif de I'émulateur

Choix de la position de I'émulateur et de la barre d'outils
e Emulator position Left/Right (Position de I'émulateur a gauche/a droite)

b
- pour alterner entre |'affichage a gauche ou a droite de I'écran de
la calculatrice scientifique. Cette fonction est pratique pour projeter sur un
tableau interactif.

e Tool Bar Top/Bottom (Barre d'outils en haut/en bas) EI - pour alterner
entre la position en haut ou en bas de I'écran pour la barre d'outils. Cette

fonction est pratique pour projeter sur un tableau interactif.
Remarque : Vous pouvez changer la disposition visuelle et/ou la position des
éléments pour optimiser I'acces, en particulier lorsque vous utilisez un tableau
interactif.

Emulator Panel (Volet de I'émulateur) : ce volet permet d'utiliser la vue totale
de I'émulateur ou uniquement la vue du clavier de I'émulateur.

Large Display Screen Panel/Key Press History Panel (Ecran d'affichage
large/Historique des touches activées) : I'un ou I'autre volet permet d'afficher
une version agrandie de I'écran de la calculatrice et/ou I'historique des touches
activées.

Les options d'affichage suivantes sont disponibles :

Utilisation de I'espace de travail de I'émulateur TI-SmartView™ pour calculatrices MathPrint™
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* Volet Large Display Screen
(Ecran d'affichage large)
uniquement

Volet Key Press History (Historique
des touches activées) uniquement

e Volets Large Display Screen
(Ecran d'affichage large) + Key o Option Hide Large Display Screen
Press History (Historique des (Masquer I'écran d'affichage large)
touches activées)

@ Resize Panels (Redimensionner les volets) : cliquez sur la barre verticale située
le long d'un volet et faites-la glisser pour le redimensionner.

Utilisation du clavier de I'émulateur TI-SmartView™

Le pointeur de la souris se substitue a votre doigt pour appuyer sur les touches du
clavier de I'ordinateur.

Cliquez sur les touches de I'émulateur TI-SmartView™ pour MathPrint™ de la méme
fagon que vous activeriez les touches de la calculatrice.

Vous pouvez maintenir enfoncée une touche fléchée pour faire défiler le curseur en
continu.

Lorsque vous utilisez une touche fléchée pour déplacer le curseur, vous pouvez
maintenir la touche enfoncée pour faire défiler le curseur en continu, ce qui évite
d'avoir a appuyer a plusieurs reprises sur la touche. Dans I'historique des touches
activées, |'icone associée a une pression répétée sur une touche fléchée est
représentée par une horloge.

Une pression répétée sur une touche fléchée a partir d'une ligne affiche une fleche
avec un compteur de répétitions.

Lorsque vous appuyez sur une touche fléchée a plusieurs reprises, une touche fléchée

s'affiche dans I'historique des touches activées ; cette touche fléchée DO est
associée a un chiffre indiquant le nombre de pressions.

Opération de glisser-déposer d'un écran dans une autre application

Vous pouvez faire glisser n'importe quel écran de I'émulateur TI-SmartView™ pour
calculatrices MathPrint™ afin de le déposer et de le coller dans une autre application.

Les écrans de |I'émulateur TI-SmartView™ pour calculatrices MathPrint™ que vous
pouvez déplacer par glisser-déposer sont les suivants :

e Ecran au-dessus du clavier dans le volet de I'émulateur
e Volet Large Display Screen (Ecran d'affichage large)

e Captures d'écran enregistrées ou non dans I'espace de travail Screen Capture
(Capture d'écran)

7 Utilisation de I'espace de travail de I'émulateur TI-SmartView™ pour calculatrices MathPrint™



Réinitialisation de I'émulateur
Pour réinitialiser I'émulateur :

1. Cliquez sur Actions (Actions).
2. Cliquez sur Reset Emulator (Réinitialiser I'émulateur).

3. Cliquez sur Reset (Réinitialiser).

& :

Reset Emulator?

Resetting the emulator will overwrite all the

contents of the current emulator state.

Do you want to reset the emulator?

CANCEL RESET

.

La réinitialisation de I'émulateur a pour effet de :

e Réinitialiser |'état actif de I'émulateur

e Effacer I'historique des touches activées

Utilisation de I'espace de travail de I'émulateur TI-SmartView™ pour calculatrices MathPrint™ 8



Enregistrement et chargement de I'état d'un émulateur MathPrint™

Lorsque vous enregistrez I'état d'un émulateur MathPrint™, un fichier contenant les
parametres de I'émulateur et toutes les modifications apportées a sa configuration est
créé.

Par exemple, vous souhaiterez peut-étre configurer une présentation en classe en
saisissant des données dans un éditeur de données et des fonctions dans f(x) et g(x).
Lorsque vous enregistrez vos modifications dans un fichier d'état d'émulateur, il vous
suffit ensuite de charger celui-ci pour afficher votre présentation. Si vous souhaitez
créer différentes présentations en fonction de chaque classe, créez plusieurs fichiers
d'état d'émulateur.

Remarque : L'historique des touches activées, les captures d'écran, le mode d'affichage
de I'émulateur et la taille de I'émulateur ne sont pas enregistrés dans le fichier d'état.
Notez que les fichiers d'état d'un émulateur MathPrint™ peuvent devenir volumineux.
Contactez le service informatique si votre capacité de stockage pose probléeme.

Enregistrement de I'état d'un émulateur MathPrint™

La gestion, I'enregistrement et le chargement d'un fichier d'état d'émulateur sont
disponibles pour chaque émulateur MathPrint™. Le fichier d'état d'émulateur TI-
30X Plus MathPrint™ peut uniquement étre chargé sur I'émulateur TI-30X Plus
MathPrint™.

Remarque : Le fichier d'état d'émulateur TI-30X Pro MathPrint™ peut uniquement étre
chargé sur I'émulateur TI-30X Pro MathPrint™.

1. Cliguez sur Actions > Save Emulator State... (Actions > Enregistrer un état
d'émulateur...).

B TI-SmartView™ for MathPrint™ calculators

File Edit View Actions Help

v E3 o [

Save Emulator State...

Load Emulator State.

Reset Emulator

=SS
(g o] [ ama ] |
() (o] 18] o] (o]

"
EE yn]us
) ls L) -]

2. Dans la boite de dialogue qui s'affiche :
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a) Accédez au dossier dans lequel vous souhaitez stocker le fichier d'état
d'émulateur MathPrint™.

b) Entrez un nom de fichier. Utilisez un nom décrivant I'état de I'émulateur
MathPrint™.

Remarque : Les fichiers d'état d'émulateur MathPrint™ sont dotés d'un nom
préconfiguré doté de I'extension *.s3l, indiquant I'état de I'émulateur de la
calculatrice TI-30X Plus MathPrint™ créé par le logiciel d'émulation TI-
SmartView™ MathPrint™. L'extension associée a I'état d'émulateur de
calculatrice TI-30X Pro MathPrint™ est *.s3r.

c) Cliquez sur Save (Enregistrer).

Chargement d'un état d'émulateur MathPrint™

Etant donné que les fichiers d'état d'émulateur MathPrint™ sont propres & chaque
modele de calculatrice, vous pouvez uniquement charger un fichier congu pour le
modele de calculatrice actif.

1. Cliquez sur Actions > Load Emulator State (Actions > Charger un état d'émulateur).

TE TI-SmartView™ for MathPrint™ calculators

File Edit View Actions Help

B =2 Capture Screen

Save Emulator State.
PN | | DEG

= Load Emulator State...

Reset Emulator

E==
\ﬂllﬂiﬁl’l ﬂ\ -

b B

2. Dans la boite de dialogue qui s'affiche :

a) Sélectionnez le dossier dans lequel se trouve le fichier d'état d'émulateur.

Remarque : Seuls les fichiers d'état d'émulateur MathPrint™ compatibles avec
le modeéle de calculatrice actif s'afficheront.

b) Cliquez sur le nom de I'état d'émulateur MathPrint™ de votre choix afin de le
mettre en surbrillance.

c) Cliquez sur Open (Ouvrir).

Utilisation de I'espace de travail de I'émulateur TI-SmartView™ pour calculatrices MathPrint™ 10



Choix d'une option d'affichage

Vous pouvez personnaliser |'affichage de fagon a montrer ou masquer les volets

facultatifs et a modifier le type d'informations présentées dans chacun d'entre eux. Par

défaut, le logiciel d'émulation TI-SmartView™ pour calculatrices MathPrint™ affiche
I'espace de travail de |'émulateur de calculatrice dans le volet Large Display Screen
(Ecran d'affichage large).

Affichage de I'écran de la calculatrice

1. Cliquez sur pour 2. Cliquez a nouveau sur pour
Hide (Masquer) le volet Show (Afficher) le volet Large Display Screen (Ecran

Large Display Screen d'affichage large).
(Ecran d'affichage large).

jm/_\/mﬁ

Choix d'un type d'émulateur

=
Cliquez sur la fleche pointant vers le bas de I'icone pour choisir un type
d’émulateur.

v Z2a@a 6
v TI-30X Plus MathPrint
TI-30X Pro MathPrint
TI-30XS MultiView

TI-34 MultiView

Chaque type d'émulateur affiche le modéle de calculatrice associé.

11 Utilisation de I'espace de travail de I'émulateur TI-SmartView™ pour calculatrices MathPrint™



Changement de fagade de calculatrice
Pour changer la fagade de la calculatrice :

1. Cliquez sur View (Affichage).

2. Placez le pointeur de la souris sur Calculator Faceplate (Fagade de la calculatrice).

3. Cliquez sur un nom de fagade de calculatrice.

Light (Clair) Dark (Sombre) Outline (Contour)

TI-30X Plus

MathPrint

TI-30X Plus

MathPrint

TI-30X Plus

MathPrint

® TEXAS INSTRUMENTS &3 TEXAS INSTRUMENTS. % Texas INSTROMENTS

s BEG

quit insert quit insert insert

o 2N

staregdstr

o e e

random  expr-eval

£ I8 B ool |18 |t

[ e e

stat-egidistr [«

dum Exw—eva\

cos Lar\
= @ (3] - - E]
constants op set op ¥ « ts op set «constants

m : FO0IG
5 s B _ Ea[Eala

Inlog | | math | | data

complex

onvert  basen <0 / 8 convert basen < convert

E clear var

5 ; (i) El E EI -
8 reca f recall
2

@@@

L] (o [ () o]

answer

©

Affichage ou masquage de I'historique des touches activées

Cliquez sur pour afficher ou masquer I'historique des touches activées.
Cliquez sur CLEAR (EFFACER) dans le volet situé a coté de I'historique pour effacer le

contenu de ['historique.

o (23K 3)
3

Key Press History

[s](-1[s]

(1]

Cliquez sur cette
option et faites
glisser le pointeur de
la souris pour
redimensionner le
volet Key Press

Cliquez sur cette
option aprés avoir
sélectionné les
touches afin de
copier la police
comme caractéeres

Cliquez ici pour

de
I"historique des
touches.

effacer le contenu

Utilisation de I'espace de travail de I'émulateur TI-SmartView™ pour calculatrices MathPrint™
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History (Historique graphiques.
des touches
activées).

Lorsque vous cliquez sur Clear (Effacer), le message d'information suivant s'affiche :

rED Key Press History [iz-r

Are you sure you want to clear the history?

CANCEL CLEAR

Copie de I'historique des touches dans une autre application

b

Vous pouvez copier la totalité ou une partie de I'historique des touches dans une autre

application, comme par exemple un traitement de texte. Vous pouvez copier les icones
B

des touches @ telles qu'elles se présentent dans le volet Key Press History
(Historique des touches activées), ou copier les touches activées comme police de

caractéres (5] -] (6].

Remarque : Lorsque vous copiez les touches comme police de caracteres, la police TI-
30X Pro Key est utilisée. Seuls les jeux de polices de touches principaux peuvent étre
collés. Les jeux de polices secondaires ne sont pas reconnus a partir de la copie comme
élément de police dans TI-SmartView™. Vous pouvez insérer manuellement les
éléments secondaires en utilisant la police installée. Cette police est automatiquement
installée sur votre ordinateur en méme temps que le logiciel TI- SmartView™ pour
calculatrices MathPrint™. Le jeu de polices comporte toutes les polices de touches TI-
30X Plus comme sous-ensemble des polices TI-30X Pro.

Copie des touches en tant que graphiques ou police de caractéres

1. Sélectionnez les touches a copier.
Pour sélectionner des touches dans le volet Key Press History (Historique des
touches activées), utilisez I'une des méthodes suivantes :

Touche Méthode
— Une seule touche : Cliquez sur une touche.
— Plusieurs touches : Cliquez sur une touche.

Appuyez sur la touche Ctrl du clavier
de votre ordinateur et maintenez-la
enfoncée.

Cliquez sur d'autres touches pour
sélectionner plusieurs touches.

13 Utilisation de I'espace de travail de I'émulateur TI-SmartView™ pour calculatrices MathPrint™



Touche

— Séquence de plusieurs touches :

Méthode

Cliquez sur une touche.

Appuyez sur la touche Maj du clavier
de votre ordinateur et maintenez-la
enfoncée.

Appuyez sur une autre touche.
Remarque : Cela vous permet de
sélectionner ces deux touches, ainsi
gue toutes les autres touches qui se
trouvent entre elles.

— Toutes les touches :

Cliquez sur une touche.
Effectuez un clic droit.
Cliquez sur Select All (Tout
sélectionner).

Remarque : voici a quoi ressemble une touche avant et apres sa sélection.

Avant : Apres :

B B

(2] [2]

Sélectionnez les touches qui vous intéressent.

Cliquez sur Edit > Copy (Edition > Copier) pour copier les touches en tant que

graphiques

ou

Cliquez sur Edit > Copy As Font (Edition > Copy As Font (Copier en tant que police)

pour copier les touches en tant que caractére de police principale) (5] (=] [6].

4. Changez d'application.
5. Collez les touches a I'emplacement approprié.
Remarque :

Vous pouvez également faire glisser les touches sélectionnées comme graphiques

dans I'autre application.

Vous pouvez redimensionner les graphiques aprés les avoir insérés dans une

nouvelle application.

Dans certaines applications, les caracteres insérés sous forme de caractéres de
police peuvent s'afficher dans la police active a cet emplacement et ne pas

ressembler a des touches de calculatrice scientifique. Si nécessaire, appliquez la

police TI-30X Pro Key aux caracteres. Pour des informations détaillées sur
|'application d'une police aux caractéres, consultez le fichier d'aide de I'application

de destination concernée.

Utilisation de I'espace de travail de I'émulateur TI-SmartView™ pour calculatrices MathPrint™
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Changement de taille du volet Large Display Screen (Ecran
d'affichage large) de I'émulateur TI-SmartView™

Dans le volet Large Display Screen (Ecran d'affichage large), cliquez sur le bord d'un
volet et faites-le glisser pour en modifier la taille.

B TI-Smartview™ for MathPrint™ calculators

File Edit View Actions Help

v s @

DEG

MathPrint

resrammeas TH30X Plus

(o] (e ][]

(= ] [
v

Key Press History I

recall fard

fone (1123 (o)

off

[en )00 [eme]

Remarque : Toutes ces opérations sont effectuées de gauche a droite, sauf dans le cas
du volet Key Press History (Historique des touches activées), ou |'utilisateur doit opérer
des mouvements vers le haut ou vers le bas pour modifier la taille du volet.

Positions de I'émulateur et de la barre d'outils

=g Emulator position Left/Right (Position de I'émulateur a gauche/a droite) -
pour alterner entre |'affichage a gauche ou a droite de I'écran de la
calculatrice scientifique. Cette fonction est pratique pour projeter sur un
tableau interactif.

= Tool Bar Top/Bottom (Barre d'outils en haut/en bas) - pour alterner entre
la position en haut ou en bas de I'écran pour la barre d'outils. Cette
fonction est pratique pour projeter sur un tableau interactif.
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Always in Front (Toujours au premier plan)

Sélectionnez cette option dans le menu View (Affichage) pour conserver au premier
plan les fenétres de I'émulateur TI-SmartView™ pour calculatrices MathPrint™ devant
toutes fenétres d'autres logiciels ouvertes. C'est comme si votre calculatrice était
posée sur votre bureau, au-dessus de tous vos papiers ! Positionnez la fenétre sur le
bureau de votre ordinateur a I'emplacement qui convient le mieux pour la conserver

« toujours au premier plan ».

Pour désactiver I'option Always in Front (Toujours au premier plan), désélectionnez
I'élément correspondant dans le menu View (Affichage). Aucune icéne de la barre
d'outils ni aucun indicateur, excepté la coche dans le menu, ne s'affiche lorsque cette
option est active.

Remarques :

La fenétre de |'espace de travail de I'émulateur TI-SmartView™ pour calculatrices
MathPrint™ et les fenétres Screen Capture (Capture d'écran) sont systématiquement
affichées au premier plan et basculent au premier plan, en fonction de leur position.

Il est déconseillé d'utiliser I'option Always in Front (Toujours au premier plan) en mode
plein écran, car toutes les autres fenétres seront masquées derriére le plein écran de
I'émulateur TI-SmartView™ pour calculatrices MathPrint™.
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Utilisation de I'outil Screen Capture (Capture d'écran)

Vous pouvez capturer les écrans actifs de la calculatrice scientifique a I'aide de I'outil
de capture d'écran de I'émulateur TI-SmartView™ pour calculatrices MathPrint™.

Pour utiliser I'outil Screen Capture (Capture d'écran)

» Cliquez sur. dans la barre d'outils.

La fenétre ci-dessous s'affiche :

"I TI-Smartview Sc

File Edit View Actions

1

5
2, (2x+1)
[8+[18
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Zones de I'espace de travail Screen Capture (Capture d'écran)

o

Capture
(Capturer)

Cliquez sur cette option pour prendre une capture d'écran de
I"émulateur.

Actions > Capture Screen (Actions > Capture d'écran)
Remarque : Une bordure s'affiche automatiquement autour
des images que vous capturez, mais vous pouvez la
supprimer en cliquant sur View > Hide Screen Capture
Borders (Affichage > Masquer les bordures de capture
d'écran). (S'il y a plusieurs images, cette option supprime la
bordure de toutes les images.)

L'outil Screen Capture (Capture d'écran) permet d'effectuer
les opérations suivantes :

e capturer 44 écrans a la fois (pour capturer des images
supplémentaires, supprimez des images existantes dans
la fenétre Screen Capture (Capture d'écran)) ;

e sauvegarder automatiquement dans la mémoire des
captures d'écran jusqu'a la fermeture de la fenétre
principale de TI-SmartView™ pour calculatrices
MathPrint™.

La fermeture de I'outil Screen Capture (Capture d'écran)

permet d'enregistrer rapidement vos captures d'écran. Vous

pouvez ouvrir une nouvelle session de capture d'écran
pendant une session TI-SmartView™ pour calculatrices

MathPrint™.

Save (Enregistrer)

Cliquez sur cette option pour enregistrer les captures d'écran
sélectionnées.
File > Save As (Fichier > Enregistrer sous)

Copy (Copier) Cliquez sur cette option pour copier les captures d'écran
sélectionnées dans le presse-papiers.
Edit > Copy (Edition > Copier)

Delete Cliquez sur cette option pour supprimer les captures d'écran

(Supprimer)

sélectionnées.
File > Delete (Fichier > Supprimer)

® © O ©

Resize
(Redimensionner)

Faites glisser le point le long de la barre pour régler la taille
de I'apercu de la capture d'écran.

View > Scale Screen Captures (Affichage > Mettre a I'échelle
les captures d'écran)

Remarque : Les écrans sont enregistrés au pourcentage
d'affichage utilisé.

@

Rename
(Renommer)

Renommez une capture d'écran en mettant en surbrillance
son titre, puis en saisissant le nouveau nom a utiliser.

O

View (Affichage)

Zone permettant d'afficher les captures d'écran.

Utilisation de l'outil Screen Capture (Capture d'écran) 18



Opération de glisser-déposer d'un écran dans une autre application

Vous pouvez faire glisser n'importe quel écran de I'émulateur TI-SmartView™ pour
calculatrices MathPrint™ afin de le déposer et de le coller dans une autre application.

Les écrans de I'émulateur TI-SmartView™ pour calculatrices MathPrint™ que vous
pouvez déplacer par glisser-déposer sont les suivants :

e Ecran au-dessus du clavier dans le volet de I'émulateur
e Volet Large Display Screen (Ecran d'affichage large)

e Captures d'écran enregistrées ou non dans I'espace de travail Screen Capture
(Capture d'écran)
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Mappage de clavier d'ordinateur

Vous pouvez utiliser le clavier de I'ordinateur pour appuyer sur une touche plutét que
d'activer cette touche sur I'image du clavier de I'émulateur TI-SmartView™.

Utilisation du clavier de I'ordinateur

Pour appuyer sur une touche de I'émulateur a I'aide de votre clavier d'ordinateur,
référez-vous au tableau ci-dessous afin d'identifier la touche du clavier correspondant
a la touche de I'émulateur.

e TI-30X Pro MathPrint™ ou TI-30X Plus MathPrint™ les raccourcis clavier

e TI-30XS-30XB MultiView™ les raccourcis clavier

e TI-34 MultiView™ les raccourcis clavier

Mappage de clavier d'ordinateur 20



TI-30X Pro MathPrint™ ou TI-30X Plus MathPrint™

Exemple : Pour afficher I'écran Mode dans I'émulateur, appuyez sur la touche [W] sur
le clavier de I'ordinateur, comme illustré dans le tableau ci-dessous.

quit

TI-30X Pro MathPrint™ les raccourcis clavier:

TI-30X Plus MathPrint™ les raccourcis clavier:

Znd (modie] delete 0] ®
[al [W] | [Delete] [<] [1~]
[In log (math] [data] ® ®
[R] [Tl vl (4 [—>1
(7107 [EE] ) [table] [clear]
[U] [ [P] [A] | [Backspace]
i) (5] 2 =) =
[D] [F] [G] [H] 11
=3 5 | 0]
[J] [K] [l [ [*1
(7] 7 B ] =]
[L] [71] [el [e1 [-1
5 [l H| 8]
[Z] [4] [5] [€] [+]
sto-] [ 2 3] oz
[X] [1] [2] [31 [c]
[on) [0] B (=) [enter]
vl [0] [.] [B] [Enter]
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*Remarque :

Sur le clavier d'un ordinateur MAC :

- Appuyez sur [Delete] (Supprimer) pour activer [delete].
- Appuyez sur [Backspace] (Retour arriére) pour activer [clear].

2nd mode| [delete] G) =
[aj [W] | [Delete] [<] "
* ['1
[In log math | [data] ] :D
[R] [T] I (-]
el 10 [Eg] [38] table] clear|
[V] [1 [P] [A] | [Backspace]
*
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TI-30XS/30XB MultiView™

Exemple : Pour afficher I'écran Mode dans I'émulateur, appuyez sur la touche [W] sur
le clavier de I'ordinateur, comme illustré dans le tableau ci-dessous.

quit

TI-30X45 MultiView™ keyboard shortcuts:

2nd 0] @
[Ql] [W] [Delete] [<1 (T
or or or
[CEril+ | [Ctri]+[ < ]
[Delete] e+ T
@ ®
[R] [T] [Yl 1 [>]
or or
[Ctri]+] —= 1
ctril[ 1
(in]
[U] [11 [P] [A] | [Backspace]
or
[Ctri]+
[Backspace]
MacE:
[Clear]
[sin] [cos] (=]
[D] [F] [G] [H] [/1
X7 0]
[J1 [K] | [Shiftl+[(] [ [Shift]+[)] [Shift]+[*]
E]] (-]
[L] [7] (2] 91 [-1
(4) (5] (6]
[Z] [4] [51 [6] [Shift]+[ +]
sto* [ 2] 3]
[X] [11 [2] [31] [C]
@ O =)
vl [o] [-1 [B] [Enter]
or
[Ctri]+[Enter]
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*Remarque :

Sur le clavier d'un ordinateur MAC :

- Appuyez sur [Delete] (Supprimer) pour activer [delete].
- Appuyez sur [Backspace] (Retour arriére) pour activer [clear].

2nd mode| [delete] G) =
[aj [W] | [Delete] [<] "
* ['1
[In log math | [data] ] :D
[R] [T] I (-]
el 10 [Eg] [38] table] clear|
[V] [1 [P] [A] | [Backspace]
*
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TI-34 MultiView™

Exemple : Pour afficher I'écran Mode dans I'émulateur, appuyez sur la touche [W] sur
le clavier de I'ordinateur, comme illustré dans le tableau ci-dessous.

quit

TI-34 MultiView™ keyboard shortcuts:

2nd ® ®

[al W] [Delete] [«1 p
or or [ 01

[Ctril+ | [Ctri]+[ <~ ] )
[Delete] et T
@ ®
[R] [T] [Y1] (1 [=>1]
or
G N
[ctrilf ]

raimp]
[ul [ [P] [A] | [Backspace]
or
[Ctril+
[Backspace]
MacE:
[Clear]

=]
[D1] [F] [G] [H] [/1
0]
[J1 [K]1 | [Shif]+[(] | [Shift]+[}] [Shift]+[*]
£l =
L1 [71 [8] [91 [-1
(6]
[Z1] [4] [51 [&] [+1

al 2] [E]

[X1] [1] [2] [3] [cl

[on] El =) enter
vl [0] [.] [B] [Enter]
or
[Ctri]+[Enter]
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*Remarque :

Sur le clavier d'un ordinateur MAC :

- Appuyez sur [Delete] (Supprimer) pour activer [delete].
- Appuyez sur [Backspace] (Retour arriére) pour activer [clear].

2nd mode| [delete] © =
[aj [W] | [Delete] [<] "
* ['1
[In'leg math] [data] ] »
[R] [T] 1| 4 (1
el 10 [Eg] [38] table] clear|
[U] [ [P] [A] | [Backspace]
*
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Informations générales

Aide en ligne

education.ti.com/eguide

Sélectionnez votre pays pour obtenir d'autres informations relatives aux produits.

Contacter I’assistance technique TI

education.ti.com/ti-cares

Sélectionnez votre pays pour obtenir une assistance technique ou d'autres types de
support.

Informations sur le service et la garantie

education.ti.com/warranty

Sélectionnez votre pays pour obtenir des informations sur la durée et les conditions de
la garantie ou sur le service apres-vente.

Garantie limitée. Cette garantie n'affecte pas vos droits statutaires.
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